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Introduction

CryptaPix is a versatile graphics viewing program for Windows 95, 98 and NT systems with 
support for BMP, GIF, JPG, PCX, PNG, and TIF image formats.    Optional encryption functions 
allow you to encrypt your private image collections and view them only when the correct 
passwords are entered.    Other features include:

· Auto-advancing slideshows
· Six transitional effects
· Full-screen viewing
· Built-in file management for copying, moving and deleting images
· WAV sound file support
· Thumbnail database
· 40-bit PC1 encryption
· 160-bit Blowfish encryption in U.S./Canada registered version
· DOD-compliant file wiping
· Multi-file renaming
· Twain-compliant image importing
· Image crop, resize, rotate, mirror, zoom, and conversion options

Software License

CryptaPix is copyrighted software distributed as shareware.    You are granted a temporary 
30-day license to try CryptaPix to see if it will meet your needs.    If you wish to use the 
program past the 30-day evaluation period, you must purchase the fully-licensed, registered 
version from the author or an authorized dealer.    Failure to comply with the license 
agreement is a violation of federal and international copyright laws.    Select "Register" from 
CryptaPix's Help menu for ordering instructions.

Disclaimer

This software is provided as is and without warranty.    The author assumes no liability for 
damages, either direct or consequential, which may result from the use of this product.

Author Contact and Technical Support Information

Kent Briggs 
14314 Cashel Forest Dr. 
Houston, TX    77069    U.S.A.

E-mail: kbriggs@briggsoft.com

Web Page: http://www.briggsoft.com



Download other Briggs Softworks programs from WWW page:

Puffer - Public key encryption for e-mail and data files

Calendar Commander- Print calendars in over 20 included formats

File Maven 95 - Dual-directory file manager for 32-bit Windows platforms

Miscellaneous

CryptaPix was written in Object Pascal with Borland Delphi

ImageLib graphics library licensed from Skyline Tools

LZW compression technology for GIF and TIFF file formats has been licensed from Unisys 
Corporation under U.S. Patent No. 4,558,302 and foreign counterparts

WISE installation package licensed from Great Lakes Business Solutions

Association of Shareware Professionals

Kent Briggs is a member of the Association of Shareware Professionals (ASP).    The ASP 
wants to make sure that the shareware principle works for you.    If you are unable to 
resolve a shareware related problem with an ASP member by contacting the member 
directly, the ASP may be able to help.    The ASP Ombudsman can help you resolve a dispute 
or problem with an ASP member, but does not provide technical support for members' 
products. Please write to the ASP Ombudsman at 157-F Love Ave., Greenwood, IN 46142 
USA, FAX 317-888-2195, or send email to omb@asp-shareware.org.



User Interface

The interface for CryptaPix consists of a menu system at the top of the window. Just below 
the menu is a toolbar containing icons that activate several of the most often used 
functions.    The major portion of the main window is divided into two sections with an image 
panel on the right and a tabbed notebook page on the left. A slider bar between the tabbed 
notebook and the image panel can be moved with the mouse to adjust the size of these 
sections.

Images are displayed on the image panel.    Double click the image panel to view the current 
image full-screen.    Press Esc to return to the main window.

The tabbed notebook contains four pages: Main, File Mgr, Slideshow, and Thumbs.    Click 
the tab to bring the corresponding page to the front. 



File Manager

The file manager page contains a directory tree, a file list, and a toolbar.    The directory tree 
is similar to the one in Windows Explorer.    Click on a directory to make it active and any 
image files it contains will be displayed in the file list.    Press the Insert key to create a new 
directory below the current directory.    Press F2 to rename the current directory.    Press the 
Delete key to delete the current directory (it must be empty first).

Click on a file to select it for processing.    Basic information (number, dimensions, size, 
date) about the file will be displayed on the lower status line.    Hold the Ctrl key down while 
clicking files to toggle their selection without affecting the other selections.    Hold the Shift 
key down while clicking to select a continuous range of files.

After selecting one or more files, you can use any of the functions on the File menu to 
process the files as you wish.    You can also click in the file list with the right mouse button 
to activate a pop-up menu that contains the same functions.

To display an image, double click its filename in the listbox or select it and press the Enter 
key.    Press the space bar to advance to the next image or the backspace key to advance to 
the previous image.    Select "Play slideshow" from the Options menu (or click the Play 
button on the toolbar) to start an auto-advancing slideshow. 

The File Mgr menu contains four functions that are also represented on the File Manager 
toolbar:

Use the Add icon to add the file names to the current slideshow list.      Click the Slideshow 
tab to see the slideshow list.

Use the Filter icon to set the file mask for the file list.    By default, the mask is set to only 
show supported image types.    You can also use this function to specify whether or not to 
show hidden files and directories.

Use the Refresh icon to update the directory tree and reload the file list from the disk.

Use the Side-by-Side icon to toggle the directory tree/file list orientation.    In the depressed 
position, the lists are displayed side by side, otherwise they are displayed one over the 
other.



Slideshow

The slideshow page contains a file list and a toolbar.    The slideshow list allows you to group 
image files in various ways without the restrictions of the file manager.    For example, you 
can include a select group of images contained in the same directory or place image files in 
different directories (or even different drives) into the list at the same time and then sort 
them as you wish.

You can also save the image list to a *.css slideshow file for later retrieval. All of the file 
processing functions (copy, move, delete, encrypt, display, etc.) that are available in the File 
Manager are also available in the Slideshow list.

The Slideshow menu contains seven functions that are also represented on the Slideshow 
toolbar:

Use the Open icon to load a previously saved list of files.

Use the Save icon to save the current list of files to a *.css CryptaPix Slideshow file.    Note 
that only the file names are saved, not the images themselves.    If you later move or delete 
a file in the list, then it will not be found when the slideshow file is loaded again.    Before 
saving the list, the program will ask if you would like to save the current viewing options 
with the list.    These are the options available on the Options/Preferences menu.    If you 
answer "Yes", those options are saved in the slideshow file and reset to those same values 
when the slideshow file is reloaded.    If you answer "No", the viewing options will not 
change when the slideshow file is reloaded.

Use the Sort icon to sort the file list by one these methods: Full path, file name, file 
extension, file size, file date, and random order.

Use the Move Up icon to move the selected file up one position in the list.

Use the Move Down icon to move the selected file down one position in the list.

Use the Remove icon to remove the selected file(s) from the list.    Note that this function 
does not delete the files from the disk, it only removes the name from the current slideshow 
list.

Use the Clear List icon to clear the slideshow list.



Thumbs

The Thumbs page contains a thumbnail viewing panel and a toolbar.    Thumbnails are small 
representations of full sized images that allow you to select files visually instead of only 
relying on the file name.    For encrypted images, CryptaPix creates and stores an encrypted 
thumbnail directly in the CPX file created during the encryption process.    For non-encrypted 
images, a central database of thumbnails is maintained for each disk volume.

All of the file processing functions (copy, move, delete, encrypt, display, etc.) that are 
available in the File Manager and Slideshow lists are also available in the Thumbs page.    A 
red box is displayed around individual thumbnails when they are selected.

The Thumbs menu contains seven functions that are also represented on the Thumbs 
toolbar:

Use the From File Mgr icon to display the thumbnails for the current directory displayed in 
the File manager.

Use the From Slideshow icon to display the thumbnails for the files listed in the current 
slideshow.

Use the Database Maintenance icon to activate the thumbnail database maintenance dialog. 
From here, you can remove orphaned and deleted thumbnails from the database files.

Use the Create icon to create thumbnails for the selected files.    This function can only be 
used on non-encrypted images.    Thumbnails for encrypted CPX files are made during the 
encryption process and stored inside the CPX files themselves.    Thumbnails for non-
encrypted files are stored in database files in the directory specified in the 
Options/Preferences dialog.    The default directory is the main program directory.    A 
separate database file is created for each disk.    The name consists of the disk’s 8-digit 
serial number with an extension of ".tdb".    New thumbnails are appended to the end of the 
database file as they are created.    An index file with an extension of ".ndx" contains sorted 
pointers that allow for quick thumbnail retrieval.

Use the Delete icon to delete the thumbnails for the selected files.    The thumbnail is 
overwritten with zeros in the database file.    From time to time, you should use the 
database maintenance function to clean the database files.    This will physically remove all 
the deleted and orphaned thumbnails from the database files. A thumbnail becomes 
orphaned when its parent file is deleted, renamed, or moved to a different directory.    
Database files will continue to grow in size if they are not cleaned often.

Use the Make Contact Sheet icon to save the current page of displayed thumbnails to an 
image file on disk.    You will be prompted to select an image format and file name.

Use the Clear Page icon to clear the thumbnail page.    Switching to another tab page will 
also clear the thumbnail page.



File Menu

The File Menu contains a set of file management functions that work on the selected files in 
either the File Mgr, Slideshow, or Thumbs page.    Click on a file to select it.    To toggle a 
single file selection on or off without disturbing the other selections, hold the Ctrl key down 
before clicking on the file.    To select a continuous range of files, click on the first file to 
select it and then hold down the Shift key before clicking on the last file.    The same 
technique also works on the Thumbs page.

Copy

The Copy command will copy the selected files to a different directory.    CryptaPix will 
prompt you for the destination directory.

Move

The Move command will move the selected files to a different directory. CryptaPix will 
prompt you for the destination directory.

Delete

The Delete command will delete the selected files.    You will be asked to select one of the 
three delete options: Recycle Bin, Normal, or Permanent Wipe.    Selecting Recycle Bin will 
cause the selected files to be moved to the Recycle Bin in the same manner that Windows 
Explorer deletes files.    Selecting Normal will cause Windows to delete the selected files 
without putting them in the recycle bin.    However, the files might still be recoverable using 
a separate unerase utility.    Selecting Permanent Wipe will cause the file to be overwritten 
with a random number stream before it is deleted so that it cannot be recovered.    
CryptaPix supports two wiping methods that can be set in the Preferences dialog on the 
Options menu.

Rename

The Rename command will rename the selected file.    CryptaPix will prompt you for the new 
name.    You can only rename one file at a time.    Use the Serialize command for multi-file 
renaming.

Serialize

The Serialize command allows you to rename multiple files at one time using a user-
specified mask.    You will be prompted to enter a prefix, suffix, digit count, and starting 
number.

Set attributes



The Set attributes command allows you to set or clear the Archive, System, Hidden, and 
ReadOnly attributes for the selected files in addition to setting the last modified timestamps. 
Use the Info command to view the current attributes and timestamps for any particular file.

Convert

The Convert command will change the format of the selected image files to any of the 
supported types: BMP, GIF, JPG, PCX, PNG, or TIF.    Note that encrypted CPX files must be 
decrypted before they can be converted to another format.    A dialog box will appear with 
various format options.    Set Colors to "Source" to keep the same number of colors as the 
original image.    Note that GIF and PCX files are limited to 256 colors.    Set the applicable 
Source Files option depending on if you want to keep or delete the original files after they 
are converted.

Encrypt

The Encrypt command will encrypt the selected files so they cannot to viewed by anyone 
without the correct password.    CryptaPix uses advanced encryption algorithms that were 
invented by cryptography professionals that have been widely published and peer reviewed. 
Due to export restrictions that the U.S. government places on encryption software, only the 
lower-strength 40-bit PC1 algorithm is available in the shareware and international 
registered versions.    Registered users in the U.S. and Canada may use the medium 
strength 80-bit PC1 or higher strength 160-bit Blowfish algorithms.

The encrypted file will have the same name as the original file except with an extension of 
".cpx". If you check the Create Thumbnail option, a thumbnail image is created, encrypted, 
and stored along with the full image inside the CPX file.    If you check the WAV file option, a 
WAV sound file will also be encrypted and stored in the CPX file if one exists with the same 
base file name.    For example, if the image file is MyPic.jpg and the WAV file is MyPic.wav, 
then they both will be encrypted (along with a newly created thumbnail) to a file named 
MyPic.cpx.    See the included Specs.txt file for a detailed description of the CPX file format.

Enter a password (or pass phrase) up to 50 characters long in the password box and then 
again in the Confirm box.    Try to use long passwords (10 or more characters) with a 
mixture of letters, numbers, and symbols to prevent brute force or dictionary attacks.    Most 
importantly, use a password that you can remember.    There are no backdoors in CryptaPix. 
You cannot view or decrypt a CPX file without the password.    Passwords are not added to 
the password queue during the encryption process.

Set the Source Files options to determine whether or not to delete the original file after 
encryption.

Decrypt

The Decrypt command will decrypt the selected CPX files back to their original format.    If 
the CPX files contained any WAV sound files, they will be restored also.    CryptaPix will try 
the passwords (if any) in the password queue before prompting the user for one.    Note that 
you do not need to decrypt CPX files back to their original disk files to view them.    Just 
double click a CPX file and CryptaPix will decrypt the image into memory only and will 
display it after the correct password is entered.



Print

The Print command will allow you to print the selected file.    Only one image at a time can 
be printed.    CPX files must be decrypted before they can be printed.    A print dialog will be 
displayed allowing you to position the image on the paper and adjust the size before 
starting the print process.

Select all

The Select all command will instantly select all the files in the current list (File Mgr, 
Slideshow, or Thumbs page).

Info

The Info function will display the file attributes for the selected file.

Exit

Use the Exit function to close and exit the CryptaPix program.



Options Menu

The Options Menu contains user adjustable settings for the program.

Play Slideshow

The Play slideshow function will start (or stop) an auto-advancing slideshow starting will the 
current selected file from either the File Mgr, Slideshow, or Thumbs page.    You can stop a 
running slideshow by pressing the Esc key.    The slideshow will advance down the file list 
unless the Reverse option is selected and will stop when it reaches the end of the list unless 
the Loop option is selected. These options along with the delay time between images can be 
changed in the Preferences section (see below).

Zoom

The Zoom option will magnify the current image by a factor of 2, 4, 8, or 16. 

Crop mode

The Crop mode function will toggle crop mode on or off.    When crop mode is on, you can 
drag a rectangular outline on the current image and then select Crop from the Image menu.

Select Twain source

Use the Select Twain source function to display and select the current Twain device on your 
system.    Image input devices such as scanners and digital cameras use Twain drivers as a 
common interface for external programs.    Use the Acquire Twain image function on the 
Image menu to import an image from a Twain-compatible device.

Clear password

Use this function to clear the password queue.    When you enter a password to view or 
decrypt a CPX file, the password (if correct) is added to the password queue.    The next 
time a CPX file needs a password, it will try the passwords in the queue before prompting 
the user for one.    You can set the Password Timeout value in the Preferences section to 
delete passwords automatically after a specified amount of time.

Preferences

The Preferences dialog allows you to set numerous display options for the program. If you 
press the "Save as default" button, all the current settings will be recorded in the registry 



and restored the next time CryptaPix is loaded. 

The Viewing options include:

Show image full screen - The display will go into full screen mode when the next image is 
loaded from the disk.    Note that you can go immediately into full screen mode by double 
clicking the image panel.    Once in full screen mode, use the right mouse button (or press 
Enter) to display a popup menu of available commands.

Play matching WAVs - If an image has a corresponding wav sound file in the same 
directory (e.g. there exists a MyPic.wav file with a MyPic.jpg file) then it will be played when 
the image file is displayed.    For encrypted CPX files, the wav sound clip encrypted within 
the CPX file (if any) will be played.

Shrink image to fit - When this option is checked, images taller or wider than the image 
panel (or screen in full screen mode) will be automatically scaled down to fit the panel (or 
screen).    Otherwise, large images are displayed will scroll bars.

Expand image to fit - When this option is checked, images shorter and thinner that the 
image panel (or screen in full screen mode) will be automatically scaled up to fit the panel 
(or screen).    Otherwise, small images are displayed at original size.

Show progress bar - When this option is checked, a progress bar is displayed below the 
image as it is being loaded into memory.

Show progress % - When this option is checked, a numerical value from 0% to 100% is 
displayed below the image as it is being loaded into memory.

Show encrypted names - When a file is encrypted to a CPX format, the original name is 
encrypted and stored inside.    When this option is checked, the original name will be 
displayed below the image after the CPX file is loaded.    Otherwise, the current filename is 
displayed.

The Transition Effects are used to load new images gradually while the previous image 
disappears gradually.    The available effects include None, Vertical bars, Horizontal bars, 
Rectangles, Vertical blinds, Horizontal blinds, and Dissolve.    Adjust the Frame Delay and 
Bar Width values to affect the speed and the look of the transition.    The Dissolve effect 
does not use the bar width value.    The transition effects work best in 16-bit (64K colors) or 
higher color mode.    A palette clash will probably occur with 256-color screen mode.

The Slideshow options are:

Reverse direction - When this option is checked, the slideshow advances up the file list 
during autoplay or when the space bar is pressed.

Loop mode - When this option is checked, the slideshow will automatically loop back to the 
beginning of the file list when it reaches the end.



Delay - Specifies the amount of time (in seconds, to three decimal places) that will pass 
before the next image begins loading during a running slideshow.

The Full Screen Viewing options are:

Show title bar - When viewing an image in full screen mode, a title bar showing the 
filename will be displayed below the image when this option is checked.

Show file # - When checked, this option will display the file number on the title bar next to 
the file name when viewing an image in full screen mode.

Background color - Set the background color in full screen mode.

The Thumbnail Directory tells CryptaPix where to store the thumbnail database files.

The three Thumbnail Size options are:

Small - the thumbnails are displayed inside an 80x60 pixel rectangle.
Medium - the thumbnails are displayed inside a 100x75 pixel rectangle.
Large - the thumbnails are displayed inside a 120x90 pixel rectangle.

The two File Wipe methods are:

1-pass - The file is overwritten with a pseudo random number stream before deleting.

3-pass - The file is wiped per DOD 5220.22-M specification for sanitizing magnetic media.    
This includes a pass of binary value 10101010 followed by the 1’s compliment pass of 
01010101 followed by a random number pass.    The Windows file buffers are flushed after 
each pass.    Before the file is deleted, a verification pass is made confirming the final pass 
was written as expected.

The Password Timeout value allows you to set the number of minutes that passwords will 
remain in the password queue before they are automatically deleted.    Use a value of 0 to 
disable this function.    Use the Clear password function to clear the password queue 
immediately.



Image Menu

This menu contains commands that affect the image that is currently displayed.    None of 
the changes made are permanent unless the Save command is used to write the modified 
image back to a disk file.

Resize

The Resize command will display the width and height of the current image in pixels and 
allow you to change these dimensions.    Check the "Maintain Aspect Ratio" option to ensure 
that the image is not distorted during the resizing.

Flip

The Flip command will swap the top row of pixels with the bottom, the second row with the 
second from the bottom, and so on.

Mirror

The Mirror command will produce a mirrored image of the original by swapping the left-most 
column of pixels with the right-most column, the second column from the left with the 
second column from the right, and so on.

Rotate 90 cw

This command rotates the image 90 degrees clockwise.

Rotate 90 ccw

This command rotates the image 90 degrees counterclockwise.

Rotate 180

This command rotates the image 180 degrees.    This is the equivalent of a flip combined 
with a mirror.

Crop

Use the Crop command to save a rectangular portion of the image and discard the 
remaining portion.    To select the rectangular portion to save, first toggle crop mode on with 
the Crop Mode command on the Options menu (or click the corresponding toolbar icon).    
Then click a starting point on the image but keep the mouse button down and drag the 
mouse to an opposite corner before releasing the button.    Click another spot on the image 
to start over if necessary.    When satisfied with the selected region, select the Crop 
command and only the portions inside the rectangular area will be kept.    You should then 
toggle crop mode back to the off position.

Acquire Twain image

Use this command to import an image from a Twain-compliant device such as a scanner or 
digital camera.    If you have more than one Twain device on your system then you can 



select which one to access with the "Select Twain source" command on the Options menu.    
CryptaPix can only import one image at a time.

Copy to clipboard

Use this command to copy the current image onto the Windows clipboard.    If no image is 
currently being displayed then the clipboard will be cleared if it contains an existing image.

Paste from clipboard

This command will paste the image on the Windows clipboard (if one exists) into CryptaPix.

Save

This function will write the current image to a disk file.    You will be prompted to select the 
format type and color depth and then the file name.

Clear

This function clears the current image from the image panel.



File Mgr Menu

The commands on this menu are documented in the File Manager section of the tabbed 
notebook.



Slideshow Menu

The commands on this menu are documented in the Slideshow section of the tabbed 
notebook.



Thumbs Menu

The commands on this menu are documented in the Thumbs section of the tabbed 
notebook.



Help Menu

Contents - Displays this help file.

Register - Displays the licensing information and order form for CryptaPix.






